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1. Aan Start > All Programs > Adobe Dreamweaver CS6

(' uTorrent &
ﬂ Adobe Acrobat Distiller Xl

A~ Adobe Acrobat Xl Pro

[Z&] Adobe Device Central CS5

Adobe Dreamweaver C55

kt-admin
ﬂ Adobe ExtendScript Toolkit C35 Documents
|% Adobe ExtendScript Toolkit CS6
|8 Adobe Extension Manager CS5 — Pictures
& Adobe Extension Manager CS6 )
[+ Adobe FormsCentral Music
i Adobe Help
@ Adobe Photoshop CS3 Extended Games
ﬂ Adobe Widget Browser Computer

'ﬁ Default Programs
& Desktop Gadget Gallery
(=2 Internet Explorer

Cantrol Panel

[ unE Devices and Printers
@ Mozilla Firefox

TeamViewer 10 _~| Default Programs

1 Back Help and Support
||Search programs and files @ Shut down | »
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1. Site > New site > Browse for folder > Select > Save > OK

DW File Edit View Inset Modify Format Commands Site Window Help Bl v &

Site Setup for Unnamed Site 8 x|
Site

site is a collection of all of the files and assets you use in your
servers website. A site usually has two parts: a local folder on your
Versian Contral «computer where you store and work on files, and a remote folder on a server
b Advanced Settings where you post the same files to the web.

Here youl select the local folder and a name for Y choose Root Folder x|
Site Name: [Unnamed Sit= 8 Select: [ adoce - ef e Er
Local Site Folder: | C:\xampp htdocsnnamed £ g Name + |.| Date modified | =| Type

.ﬂwehs\te—vdi 16/9/2558 13.35 File folde:

Recent L. memory 15/9/2558 21:54 File foldel
Places

L4

Desklop

Libraries
[ re | -
)

|| Resources» Computer

[ Dreamweaver Exchange »

*
A
|| Dontshow again Ll
Network

gﬂﬁ 2 WARTURBUNSIUALYIUY Site (folder)

(R (e | =
Iﬁ Unnamed Site j ILomI view ;I
IR IL

| size[14]
SpryAssets F
Templates F
" dinical technolog... 15KB P
dinical technolog... 15KB P
dinical technolog... 16KEB P
W dinical technolog. .. 15KB P
Contact Us.php 16KB P
Cost and Forms.... 14E P
Download.php 14%E F

examination Cent... 14#BP
examination Cent... 1¥EP
examination Cent... 14EP
o examination Cent...  16KB P

Finance.php 14%E P

image.php 20KB P

index.php 2B P

insurance.php 14EF
»
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DW File Edit View Insert Modify Format Commands Site  Window Help By v &~

main.php X ‘

a
Y myconnectphp  SpryMenuBarjs  SpryMenuBarHorizontsl.css  SpryMenuBarVertical.css  csprajadwoff2  ceprajadsvg  stylecss  jqueryjs  wowsiderjs  scriptjs  easy_rotator.min.js T
| Code | Spit [ Desgn | lve | . G M 6% B R O Tee | aoduiSuasien v
@ Dynamically-related fles cannot be discovered because a testing server is not defined. Setup o
duiuadasian neswemsuatinAnwu daling AuUWEaAITNFaLA =
:
a v o
ATNNEITABNNITATU AL,
fered by EsssRotslor. &
e and easy JQuery sider bulder
from DWlzer.com. Piease enable
FRagsnme afan 1 devind 2553
szl 2658
ﬁ13WmUs:u1ﬁuw,
H e fn o 52
4 13
<body> <table> <tr> <td> <table> <tr> <td> <table> <tr> <td> <table> <ir>[<td>| [ [&@ Q [100% «| ® [N B [1114x 446 v [1K/ 1sec [lnu (Windows)
= — —
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Fupsumaifugunimazausunm Susoudtal

1. msaugunm dansaidengunmiifesnisau udnm Delete léilae

2. maisgunin WG Insert > Image > dlmesiAuguam > 1dengunn >
OK > OK

DW File Edit View Insert Modify Format Commands Site  Window Help — [ENv  &v &+

main.php X |

a
IS mycomnect.php  SpryMenuBar.js  SpryMenuBarHorizontal.css  SpryMenuBarVertical.css  csprajad.woff2  csprajad.svg  style.css  joueryjs  wowslider.js  scriptjs  easy_rotator.min.js T
Code | Spit | Desion | tve | G G @ Selectimage Source x|
@ Dynamically-related fles cannot be discovered | g et fle name fiom: @ File system Site Aot =]
- o

€ Data sources Server Image preview b by EasuRotstor. 2 =

uery sider buider
Lookin: | ), images -led e m

& yasins

m. Piease enabie

4l w
=

i =1

psd wellcome — admin_login

215 % 209JPEG, 40K /1 sec =

Fie name:  [admin_login oK | IDNSSL '
Fles oftype:  Image Fies (" gf." jpg:" peg.” png.” psd) | Cancel

i Besaie

* URL: [images/admin_login ipg
Retivete  [Docunent =] meinphe

Channe default Link Relative To in the site definition

" Username [V Preview images
Y -
A | 3
<body> <table> <tr> <id> <table> <tr> <td> <table> <tr> <td> <table> <tr> <td> [%|& Q [100% ~| @ [ [ [1114x4% [/ Lsec [lus (Windows)

SUN 5 wansdumaumsiiiuguainiazaugunin



(% (%

FunpuM IR Ttuneudsil
1. AANYI1IASITLS1609n158519m1519 > Table > Insert Rows or Columnn > 93]
b ddmautiuan
1.1 Above the Select (Funsadransianeuntini)
1.2 Below the Select (LﬁuﬂWia%WQmWiwqwﬁﬁwﬁﬂﬁ)

L | UAANS/AMINUD

|
454 (434) l i -
v 3 and easy jQuery shider buider
H Paragraph Format > erge Cells Crl + 21+ DWUser.com. enable :
List v Split Cell... Ctrl+ Alt+S T
Align v BScript to view :
9 Insert Row L
Font 3 . :
Tl ' Insert Column Ctrl+5hift+A HE
tyle Insert Rows or Columns... B
55 Styles 3
T - N Delete Row Ctrl+Shift+ M
s Delete Column Ctrl-+ Shift+-
InContext Editing ¥ Insert Rows or Columns ll

Element View 3

Insert: ' Rows oK |
Code Mavigator... " Columns c | [

. . ance | C
Edit Tag .. Shift+F5 Number of rows: m

Insert HTML... =
Make Link Where: ' Above the Selection
& Below the Selection Help |

Open Linked Page
Add to Color Faverites

[h|e2 O [100% ~| m [W] (W] 1119446+ 1K/ 1sec [ln
Create New Snippet

Cut
Copy

vl
Paste Ctrl+V
Paste Special... e Properties...

Properties
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1. @engunmisedemnufidesnisladed > Properties mugUnmsnudng

hopertis [

e Image, 229K Src IimagesfsS.jpg 3 Alt I ;I
]IJI— Link I:J'Press Releases-1.pdf |y 03 | Edit &7 2 ° K @;

Map I— Target I _blank ;I

(k] OOR Criginal o
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2. azfiwthmddneuiuinudnden lndndesnsideulsaded mugunmauang

DW Fie Edit View Insert Modify Format Commends Site  Window Help By v S+

main.php X ‘ =1
myconnect.php  SpryMenuBar.js  SpryMenuBarHorizontal.css  SpryMenuBarVertical.css  csprajad.woff2  csprajad.svg  style.css  jquery.js  wowsliderjs  saiptjs  easy_rotator.minjs T
Code | spit | Design | tve | LY. @ [ SelectFile
@ Dynamically-related files cannot be discovered  5icct il name from: @ File system Site Root (=]
" Data sources Server
Lookin: | Ik -l ® e m-
Name = IvI Date madified IvI Type |v| Size IvI d
L/News and Events-3 18/8/2558 16:28 Adobe Acrobat Do. 870 KB INS/FLIHUD

ngsws and Events-4 1/9/2558 12:32 Adaobe Acrobat Do 1,565 KB " ot

FENews and Events-5 30912558 21:02 Adabe Acrobat Do 1,716 KB BT

FhNews and Events-6 /912558 2245 Adabe Acrobat Do 1483 KB i e

FENews and Events-7 10/9/2668 21:54 Adobe Acrabat Do 4,207 KB m. Piease enabie —

ngews and Events-8 14/9/2558 16:00 Adobe Acrabat Do... 1,709 KB 0

ﬁpasitian 16/7/2558 17:24 Adobe Acrobat Do... T7KB

'@F’ress Releases-1 19/8/2558 14.04 Adobe Acrobat Do.. 392KB |

TEPress Releases-2 1/9/2558 12:23 Adobe Acrobat Do.. 354 KB - '

File rame:  [News and Everts-8 OK
Fies of type: [ Al Fles (") | Cancel

URL: [k /News and Ewents-8 pof Parameter:
Relativeto:  [Document _»| mainphp =

Change default Link Relative T in the site definition NONSSL
4
4
<body> <table> <tr> <td> <table> <tr> <td> <table> <tr> <td> <table> <tr> <td> <a> [<imq>] @e'y Q [w00% «| m W @ \1114)( 296 v |]_Kf152c ‘ivm (Windows)
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nslilusunsu FTP aeluefetnevesminerds TrufdRmatuneussi
aflnanlusunsa SSHSecureShellClient-3.2.9.exe Wieldlusunsudananaudqlddndaasuy
\3espauTAes

SoH5ecOrEshEll
Client=512i55

SUT 9 wansdnydnuallusunsufinga SSH Secure Shell Client-3.2.5

Double click # icon mxgin 9 ivevinnsdasslLlsunsy antuiuazuananiins1sunn Asgn 10

Open File - Security Warning &’

The publisher could not be verified. Are you sure you want to
run this software?

Name: SSHSecureShalClent-3,2.5.8x8
Publizher.  Unknown Publisher

Type: Appdcation

Frome  C:\Documents and Settings\NU\Deskiop

r,

lRm || Cancel |

(V) Abways ak belore oparmg this fle

Thas file doas not have a vald dighal signaturs that verifiss s
publisher. Ywm.ldonvnnadlwug’hommb&hrsywm
How can | decide what software to run?
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nvteinalugun 10 Wiedndy Run Wesunisinadusunsy Werdnuaiduazianeniieiig
Aagun 11 Timdndu Next

SSH Secure Shell for Workstations 3.2.5 Setup @

Welcome to the SSH Secure Shell for
Workstations 3.2.5 setup wizard.

Thank you for downloading SSH Secure Shell for
Workstations, This is a non-commercial version of the
software, which does not support certificates or PKI.

To continue, click Next.

Next > Cancel l

gﬂ‘ﬁ 11 wanansinRdlusunsa SSH Secure Shell Client-3.2.5

niufasdgmiiely daguin 12 Tiedndu Yes

SSH Secure Shell for Workstations 3.2.5 Setup

License Agreement
Please read the following license agreement carefully.

Press the PAGE DOWN key to see the rest of the agreement.

Non-commercial V ersion License agreement for A
SSH Secure Shell for Workstations 3.2

SSH Communications Security Corp

SSHa Secure ShellTM) License Agreement

SSH COMMUNICATIONS SECURITY CORP ("SSH") 1S WILLING TO

LICENSE THE SSH SECURE SHELL FOR WORKSTATIONS 3.2 SOFTWARE

AND ACCOMPANYING DOCUMENTATION (COLLECTIVELY, "SOFTWARE")

UPON THE CONDITION THAT YOU ACCEPT ALL OF THE TERMS OF THIS v

Do you accept all the terms of the preceding License Agreement? If you choose No, the
setup will close. To install SSH Secure Shell, you must accept this agreement.

< Back Yes No |
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Mnuufasigmiinwely dgun 13 Tiedndu Next deluises q aumshnduasadu

SSH Secure Shell for Workstations 3.2.5 Setup

Choose Destination Location
Select folder where Setup will install files.

Setup will install SSH Secure Shell in the following folder.

To install to this folder, click Next. To install to a different folder, click Browse and select
another folder.

Destination Folder

C:\\SSH Secure Shell Browse...
< Back Next > I Cancel |

g‘d‘ﬁ' 13 wanansAnRdlusunsa SSH Secure Shell Client-3.2.5

dlenshnsuasaseusosudaiiuazuanaieingdsgun 14 liedndu Finish

SSH Secure Shell for Workstations 3.2.5 Setup

Setup Complete

Setup has finished installing SSH Secure Shell on your
computer,

SUTl 14 uansnsAndalusunau SSH Secure Shell Client-3.2.5 Foufosudn

MANAARILUTUNTULAITE Icon SSH Secure File Transfer Client wandeg#l desktop ¢4
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dladesnslalusunsy 1 double click 1 lcon #sgudt 15 axusnguiienswes
1Usunsu SSH Secure File Transfer Client ﬁﬂgﬂﬁ 16

8 - defaultsftp - SSH Secure File Transfer

Eile Edt View Operation \Window Help
B 28 B 90 % 1@ nrER SN0 eN
& Quick Connect  __| Profiles
B @ ek X vl add | B A WX I
Local Name / Size | Type A | Remote Name Size | Type
DMyDocumenls System
% My Computer System
‘ﬁMy Network Places System
# Recycle Bin System
,Olntemet Explorer System
ACDSee 9 Photo Manager 2,565 Shortcy
- Adobe Acrobat 7.0 Professi... 1,734 Shortcw
8 Adobe Reader 7.0 1,740 Shorta.
Mindjet MindManager Pro 6 2,675 Shortcu
3 Nero Startsmart 2,321 Shortce
() QuickTime Flayer 1,626 ShortcL
DReaPlayer 897 ShortcL
SSH Secure File Transfer Chent 1,936 Shortc.
=J55H Secure Shell Client 990 Shortc o
il T e >
Transfer | Queue |
/  Source Fie Source Directory Destination Directory Size | Status Speed Time
< >
Go to parent folder a

U7 16 uansmidnswealusunsy SSH Secure File Transfer Client

AanfYy Connect - #3oUal Quick Connect

'
o o

& Quick Connect

7 Tool bar visaL@an

A4 File 1 Menu bar udaiende Connect #38 Quick Connect MIgUN 17 Wielsun1s

a |

AARMDAULAT DL VBN INGNEE

fa - defaultsftp - SSH Secure File Transfer

Ele Edt Yiew Operation Window Help
IO I BRI AR 15
(&) Quick Connect | __| Profiles
B A m | ek X o] nod | B | @ 2 | ek X ]
Local Name / Size | Type A | | Remote Name Size | Type
DMy Documents System
i My Computer System
Ny Network Places System
#J Recycle Bin System
@ Internet Explorer System
JE) acDses 9 Photo Manager 2,565 Shortct
I\ Adobe Acrobat 7.0 Professi,.. 1,734 ShorteL
8 Adobe Reader 7.0 1,740 Shortc
o Mindiet MindManager Pro 6 2,675 Shortc
9 Nero StartSmant 2,321 Shortc
() QuickTime Flayer 1,626 Shortel
(PDReaPlayer 897 Shortcl
Essn Secure File Transfer Client 1,936  Shortcw
J55H Secure Shell Client 990 Shortew o
il TE e >
Transfer | Queue |
/  Source Fie Source Directory Destination Directory Size | Status Speed Time
< >
Go to parent folder A

g‘Uﬁ 17 wanansidanttAnda Connect way Quick Connect 310 Toolbar
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dll a A a . v v ° Y] ° a a 1
\Wlomdniden Connect %38 Quick Connect WA9EUIINMUIAAINTUNMIINUATOLATOI
918 (Host Name) idiaan1shinse uastiogld (User Name) Aaguil 18

| - default - SSH Secure File Transfer

|| Ble Edt vew Operation window Hep - }
[B2s we aa(% s+ @ e RRg o en
|| Easeces e |
| ot @ = |ak x|l <l add | @ m ek X ]| s |
Size | Type

Mindjet MindMar Port Number. [z
€% Nero StartSmart f -
(@ QukiTime Playe Authentication Method: | <Profile Settings>

RealPlayer T O

_SSHSecueFiﬂruuferGent 1,936 Shorteu
i SSH Secure Shell Chent 990 Shorta
g | -l >
Transfer | Queve|

/| Source Fie Source Drectory | Directory | Size | Status Speed  Time |
< I >
Not connected - press Enter or Space to | \7& = Z |

JUT 18 uanainsnaiielinsente Host Name wag User Name

\lold Host Name wag User Name walinaly Connect agusingutisinalvildsiasiudisgy
i 19

fa staff.kmult.ac.th - default - SSH Secure File Transfer

|| Ble Edt View Operstion Windw Hep ) -
s R 88 % B erEnsEy 0 ew
H.jq\xkc«m:t w_gmues‘

2| S| ek x lm*af‘m | i % 7] | asd |

&Imw«
ACDSe 9 Photo MRS LT

©) QuickTime Player 1,626 Shortcu
RealPlayer 897 Shorte,
|SSH Secure File Transfer Client 1,936 Shorteu
S5H Secure Shell Clent: 990 ShortcL &

i “'B <

Transfer | Queue |

/ | Source Fie Source Directory | Desti Directory Size | Status | Speed | Time |

53

< >
Connecting to staff kmutt.acth... | [ A A
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|| e Edr yew Operation Window Help
(@ ss el on% i tE wrEm BB O ON
RSl Baed
=g m= x|l o) e @ @ | x| [l ]| au
Local Name | Al Ske Type A [[Remcte Name 7] Size | Type
My Documents System C Folder
9 My Computer System
Qmmwkﬂaus System
# Recycle Bin System
Internet Explorer System
ACDSee 9 Photo Manager 2,565 Shorta
A Adabe Acrobat 7.0 Professi... 1,734 Shorta
8 Adobe Reader 7.0 1,740 Shortey
oG Mindet MindManager Pro 6 2,675 Shorta. —
% Nero StartSmart 2,321 Shortou
@) QuickTime Player 1,626 Shorta
RealPlayer 897 Shorta,
SSH Secure File Transfer Client 1,936  Shortew
i |SSH Secure Shell Chent 990 Shorta
<‘ - ‘ - ->'\ i‘ Al Zv
(Transfer] quece|
/ SourceFle  Source Directory | Destinstion Directory | Size | Status | Speed | Time |
< il >
Connected to staff knwtt, ac.th - fsanfhi /SSH2 - aes128-cbc - hemac-mdS - none 1 ikems (0 Bytes) [ |
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113 Upload Wuledluliuuiaiassivngvasuminenay

35M3 Upload Tnaiulerduuunsesaiinevirlalae Tirdndonlvaludiuves Local
Name(@ud1e) walrainu111ae1l3ludiuves Remote Name (#11971) ndsantunay
(v < 1 a‘d' ) gj I3 4' [N v I3 5 ¥ 1
dunaiuinlnaisvihnsanintugnituenliluiesssusitnewad Inelnddudesegniely
Tutawwas public_html

1 < ¢ & v a v 14 & 1 .
e lun1sadredulediu luntiusnideanslikaninisasdadn indexhtml
A = = & o a 19 . X Y] wa
WesnllesBengiuiiuasionyin indexhtml Yusnlaggnluii

8 staff. kmult.ac.th - default® - SSH Secure File Transfer

|| He Edt Yew Operstn Widow Hep P O
| = 3 | b e | f |
Ay Bl :33';% 3 4 ||E@] % - S Wy O SR
u &) Quick Connect ) Profiles
(@ @ m | ck x| [oeskiont 7] | add | By | &Y @ ® | ok | [oubic el <] | add |
Local Name: / Size Type A / Sze Type
9 Nero StartSmart 2,321 Shortc. | 4] index.html 330 HTMLDC
() QuickTime Player 1,626  Shortcy
(DreaPlayer 897 Shortcu
Esmsecueﬂenmfacm 1,936 Shortcy
J55H Secure Shell Clent 990 Shortew
)images File Fol
_)mainweb File Fol
W CyberLink PowerOVD 1,686 Shortcl
Pearrivs 2 703 Shortcy
&]index 344 HTMLD
L8 ]net_service 16,510 HTMLD.
notes 567 ShortcL
SSHSecureSheliClient-3.2.5 5,505,024 Applicat
Winamp 654 Shortcu o
< ) E £ >
Traste | Qe
/| Source File Source Directory | Destination Directory Size | Status | Speed | Time
4 index.html C:\Documents an...  fsanfhome/newdd... 344 Complete 7.0kBjs 00:0..,
Connected to staff kmutt.ac.th - fsan/ty SSH2 - aes128-cbe - hmac-mdS - none 1 items (330 B) AT

JU7 21 uanens Upload IndfuuuinIaausig



msaulnduazlnawmas

13

Whumsauldiu dndulndnlildeglulwawestuiamnsaaveenldies Fl 4 ey Ao

ax A a = s v Yy oA g ¥
/N 1 ﬂaﬂm’]mwalvﬂawmamﬁau waltaan Delete f\]’muuﬁ]zﬂiﬁﬂgwmmﬂ

Confirm Delete Tvinanidan OK

759 2 AdnTelidfidesnisau wadlufiluy Operation wadtdian Delete 91nTUAL
Usangmiising Confirm Delete lvimdniden OK
5% 3 Aanvelwaidesnisau wdnden X 7 Toolbar 91AUUILYTINYNUIAN

Confirm Delete Tvinanidan OK

o9 4 eAnvelnanden1say uinnaly Delete vuRguasn 31NUUALUIINYUUIAI4

Confirm Delete Tipdni@an OK

f& staff.kmutt.ac.th - default - SSH Secure File Transfer

&) Quick Connect |__] Profiles

Ele Edk View Operation Window Help
B A2 B0 90 % 3¢ 3 %

=13

EmSNK O &N

,laﬁ,,ﬁgﬁd}{[ jv'w%ﬁ@’& oF X || tmlfimages v || add

Local Name /

Size Type A | Remote Name

/ Size  Type
)My Documents System e
i My Computer System @badgiql Open Qo ee
3
: i o | ] ¢ ¥
& internet Explorer System { Rowrload Didkg... COHD
3] ACDSee 9 Photo Manager 2,078 Shortew B2 copy CtriC
v O S pdoee |
- Adobe Acrobat 7.0 Professi... 1,739 Shortau 2ete
ThaiSoftware Dictionary 1,947 Shorto Rename F2
S Windows Live? Messenger 1,832 Shorta
S mainweb File Fold (" Properties
) Outlook Express File Folc
_Jset_outiook File Folc
ez i oy
< > < >
Transfer | Queue |
/ | Source Fie Source Directory Destination Direct... Size | Status Speed Time | A
JL image25.jpg  jsharefttmijorga...  C:\Documents an... 33,840 Complate 2589.3k... 00:0...
& images.ipg Jshare/remiforga...  C:\Documents an... 34,902 Complete 371.3kB/s 00:0...
& image7.ipg [sharefhtmiforga... C:\Documents an... 41,912 Complete 222.9kBfs 00:0...
Delete selected items SSH2 - ae5126-cbe - hmac-mdS - none 1 selected (43 B) ﬁ

JUN 22 wanansaulndisg 1



f8 staff.kmutt.ac.th - default - SSH Secure File Transfer

|| Ble Edt yiew | Qperation Window telp - - .
@ s ®a o= o By - EEE WY O SN
H_»ijkam & Upload

|| & gu & Rownad )| 2 @ | ok X | [wmimooes <] | asd |
Locd“ame 2 o emote Name /| Sze  Type
[0y Docunents, | 2opboad Chalog QHD  Bbeck left.of ) 43 ACDSes
4 My Computer back_right. 1pg 593 ACDSee
N3 My Network Places bg.ipg 344 ACDSee
#) Recycle Bin (3 v
@ internet Explorer £} Home CtrlH

ACDSee 9 Photo ¥

e s shg SO0 Eckec. CtrkG

- Adobe Acrobat 7.0 (= New Folder CtriN

ThaiSoftware Dictis

5 Windons Live? be: ><I
| _)mainweb
|2 Outlook Express
|2)set_outlook ﬁ‘m«&s
o
A?oilx File Transfer Mode 3

v >

TransfulQueucl

/| SowceFle | SourceDirectory | DestimationDrect... |  Sie Status | Speed | Tme| 4|
4 imagezS.ipg  fshare/htmiforga... C:\D an.. 38,840 Complete  2589.3k.. 00:0...

& imaged.ipg  Jsh 8., CAD: an.. 34,902 Complete  371.3k8fs 00:0...

& image7.jpg [sharefhtmlforg: CHDx an... 41,912 Complete 222.9k8fs 00:0... =
Delete selected Rems SSHZ - ae5128-che - hmac-mdS - none 1 selected (43 B) - Y |

1J1'7i 23 wanansaulwding 2

4 staff.kmutt.ac.th - default - SSH Secure Fite Transfer

| Ele Edt View Operation Window Help

ICEY L R R
| &) Quick Connect  (_J Profles

@/ gme g x| s & Aa e o x| [mimees <] | as
Local Name: 7] g Siee | Type
43 ACDSee
593 ACDSee
344 ACDSee
2,078 Shorto.
1,729 Shortoe
1,739 Shortey
1,947 Shorteo
1,832 Shortcu
File Folc
File Folc
File Folc
1,000,960 Wkrusov
" T >
Direct... | Size | Status
C:\Dr an.. 33,840 Complete
. Ci\Documents an... 34,902 Complete -
D an.. 41,912 Complete  222.9k8js ooo
Connected to staff kmutt.ac.th - fsanftn [SSH2 - aes128-che - hac-mdS - none 3 tems (980 B) A
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ADUMLSNALLNLANNISAARDAULATDILUYIBUY L51AITVIINTS Disconnect 8anAdu YIA1UITON

Iélow Adnii & uu Toolbar w3eAaNTLY File udIGeN Disconnect Magu#l 25

& staff.kmutt.ac.th - default - SSH Secure File Transfer
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